PLAYING MIDI FILES USING MELODY ASSISTANT

A USER'S GUIDE FOR THE COMPLEAT IDIOT

(© David A. Goldberg, March 2, 2002)
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Prefatory notes:  

A brief word about these notes.  Melody Assistant (hereafter referred to as "MA") is a very powerful program which does many things.  Most of them are not covered in these notes.  What these notes tell you about are the procedures necessary to use existing MIDI (or .mid) files either for learning and rehearsing choral concert pieces or for practicing and improving your sight-singing.

With the exception of the section immediately following, this is a strictly paint-by-the-numbers, step-by-step manual.  In musical parlance, it teaches by the Suzuki method.  You do; you learn.  Which is to say there is no "big picture," no overview of the program.  You want to load a file?  Go to the section on loading files.  It will take you through the procedure step by step.  

It's the hope that as you go through the various procedures, you'll get a feeling for how the program works, and maybe even acquire the confidence to step off the prescribed path, and look into some of the features not described here.

A cautionary note:  Do not be intimidated by the length of the explanations.  They could be made much briefer.  And as a consequence, they would be much harder to follow.  The length of the descriptions of the various steps (and in fact their enumeration as separate steps) is the result of my attempting to cross all the t's and dot all the i's, so that you'll know exactly what you'll see, and exactly what to do at each step.  

An illustration may be helpful:  I could have shortened the manual by omitting the entire section entitled "Loading a File", and simply made the first instruction under "Playing a File" read "Start out by loading a MIDI file (period)."  Well, some of you would have had no trouble doing that, some of you would have persisted for some time and figured it out, but I suspect that after about 15 minutes some of you would have said "Well, this may be a great program, but I can't figure out how to use it."  

Enough said.  On to the instructions.  

Four Introductory Items
Much as I'd like to get straight to the step-by-step, there's some overall "background" material that is desirable, if not absolutely necessary, to keep in mind when running the program or reading the notes.  Unfortunately there's no context in which to place all this material.  So maybe the thing to do is to glance over it so you'll know that it's here and what it's all about, and then go on to the step-by-step, referring back to this material on an as-needed basis.

Oh, one more thing before you get started.  When you first open MA, it automatically loads a really neat demo MIDI file.  (In fact, why don't you do that right now!)  If you'd like to play it "just for kicks", just hit the space bar.  In fact, once you do this, and see what playing MIDI files is all about, you'll be hooked; "I guarantee it."

O.K.  Here is the background material.

On-Line Help
One of the nicest features of MA is a "dynamic" help window.  This window shows the function that can be accomplished by clicking on the pointer's present location (including the various menu selections.)  As you go through the instructions below, you might find it helpful to read what appears in the window as you move the mouse around.

Help is also available through an on-line instruction manual.  The manual can be accessed in a variety of ways.  Some of the tool palettes (see below), and some of the specialized windows contain an icon which looks like an open book lying flat on a table.  Clicking on that icon opens the relevant section of the manual.  For Mac users, the entire manual is accessible by clicking on "Documentation" under the Apple menu (I believe it's called the "system" menu for PC's).  

For reasons I'm not clear on, the documentation is actually read by a browser program, so you'll need Netscape, Explorer, or some other program capable of reading .html files to look at the on-line documentation (but since you acquire the program by downloading it from the Web, that would imply you have such a browser).

PC users only:  If you can't find the "Documentation" item under any of your menus, the individual documentation files are located in the "English" folder inside the "Docs" folder within the MA folder.  Use your browser to open the file called "summary0.htm".  This will give you a click-able table of contents.

Tool Palettes
To make possible the enormous versatility of MA the program utilizes a variety of specialized tool palettes which activate the features related to specific tasks.  These palettes can be opened individually by going to the "Windows" menu.  

Most of these palettes will not be needed for playing MIDI files (in fact, for the most part, the only palette you will need will be the "Play tools" palette which controls such things as the play, pause, fast-forward/reverse, and volume controls) so there will be no point to opening the other palettes (they'll just clutter up your screen).  

To see if a particular palette is open, go to the "Windows" menu, and pull it down.  If the palette is checked, it's open (i.e. you'll see it somewhere on your screen).  As my copy of MA  arrived "from the factory," I believe the only already-open palette was the "Play tools" palette.

The palettes can be re-positioned by clicking on the blue bar at their left hand end.  Also, the normal orientation of the palettes is horizontal; you may find them less obtrusive when they are oriented vertically.  To change their orientation, double-click (at least with a Mac) on the blue bar.  

Note that when you attempt either the re-positioning or re-orienting of the palette by placing the pointer over the blue bar, both these operations appear in the help window.  More generally, placing the pointer over (almost) any cell of a palette will cause a description of that cell's function to appear in the help window.  

Keyboard Shortcuts:

I myself prefer to use keyboard shortcuts when they are available.  When these are available I'll refer to them in Macintosh notation (e,g,, command+O); pc users should interpret this as control+O.  

Incidentally, you may find many of MA's keyboard shorcuts non-intuitive (i.e., the letter of the key seems to have little relation to it's shortcut function).  I think that the explanation for this is not that the MA folks were trained by Microsoft (a number of statements in the documentation make it clear that they are in fact Mac people), but rather that they are French, and my guess is that most of these short-cut keys correspond to the word that appears on the menu of the French language version of the program.  For the Mac users who are resourceful enough (no pun intended), you can change the short-cut keys using ResEdit, or define your own using the utility QuicKeys.

A Note on File Formats
The term MIDI (Music Instrument Digital Interface) refers to a process by which musical notes (and musical scores) are converted to and from digital information.  Once this information has been created, it can be stored in a variety of formats.  Most of the MIDI players seem to have their own proprietary format (i.e. one which can only be read by that particular "brand" of MIDI player) for storing music files.  

The situation is very similar to what goes on in the world of word processors:  Microsoft Word, for example, stores its files as .doc files (Mac file type is WDBN), a format that other word-processors cannot read (unless they use translators).  One of the few readily exchangeable file formats for MIDI players is the .mid file (Mac file type is Midi), known as a midi file (an unfortunate choice of name, since it's hard to hear the difference between capital and lower-case letters when they're spoken).  The .mid file is to MIDI players sort of like the .txt (or TEXT) file is to word-processors; consistent with that analogy, the .mid files aren't able to store quite as much complex information as the proprietary formats (e.g., they don't employ repeats, D.S. al fin, etc., and they have a very limited capability of dealing with lyrics),  However, they can store information on tempo changes and dynamics, so they're not quite as "plain vanilla" as their .txt analogs.

MA can, of course, read and write .mid files.  Its proprietary format is .mus (Mac file type DHAR); if you make any modifications to your .mid files, MA will store them as .mus files, leaving your original .mid file unaffected.  So far I've not found anyone who uses a MIDI player other than MA who can read .mus files.

For the remainder of these notes, when the term MIDI file appears, it refers to any file, regardless of its storage format, which employs MIDI encoding of musical information.
Loading a File:
1.  Do a Command+O, or click on "Open" under the File menu.  This will bring up a window showing a directory from which you're asked to choose a file.

2.  As my copy of MA  arrived from the factory, the directory (folder) opened to was the Melody Assistant folder, and the "Show" window/bar under the list of files was set to "Standard files (*.mus)", i.e., the proprietary format of MA.  To see the .mid files, you'll have to use the selector arrows at the right hand end of the "Show" window to select either "All files" or MIDI files (I find the former choice preferable, since it enables you to see both .mus and .mid files at the same time).  

There are some .mus files located in the Demos folder inside the Melody Assistant folder.  If you want to "bookmark" the existing folder for future easy return, click on the middle icon at the top right of the window (the one that shows a folder with a sort of ribbon around it), and select "Add to favorites."

Unless you've put your own midi files (e.g., the ones you've previously downloaded) in the MA folder, you'll have to navigate your way to the folder in which you stored them.  You do that using the window/bar above the directory listing (which at this point will probably say "Melody Assistant", i.e. the folder you're in at the moment).

3. When you get to the folder where you've stored your .mid files, select the file of your choice and click on the "Load" button.  The corresponding sheet music should appear on your screen.

4. Before proceding further, you'll probably want to maximize the vertical height of the window, if necessary, to see all the parts.  If you are unable to see all the parts (this will be a function of both your screen size and the number of orchestral parts), in particular the vocal parts, it may be necessary to scroll the window vertically.  An alternative to this is to scale down the score size by selecting the appropriate Zoom option under the "Windows" menu.  (If you find neither of these solutions to be satisfactory, there is a way to combine multiple instrument staves onto a single staff using "Multi-voice staves" under the "Edit" menu; I've not found it necessary, and I've not documented that feature in these notes.)

Playing a MIDI File:
Introductory Cautionary Note:  

As my copy of MA arrived from the factory, the mouse pointer was activated to serve as an editing tool:  When the pointer was placed anywhere on the score, it would morph into a musical note (in my case a whole note).  What this means is that if you click on the mouse, that note will be inserted into the score at the location of the pointer.  This can be very annoying, and also desctructive.  (If you have already inadvertantly added one or more notes, you can rid of them by going to the "Edit" menu and clicking on "Undo added note" or doing a Command+Z (repeat as many times as you've added unwanted notes; MA can sequentially undo something like 64 unwanted steps).

If you find that  your copy of MA arrived with the pointer activated as an editing tool, you can convert it back to a "normal" pointer as follows:

1.  Under the "Windows" menu, click on "Editing tools."  (If you find that item already checked when you pull down the "Windows" menu, it means the editing tools palette is already open, so omit this step.)

2.  Locate the editing tools palette on your screen.  It consists of a horizontal row of 1 cm square windows (which I'll call cells), the left-most one of which looks like a musical note with a pencil alongside it, and the right-most one like an open book lying flat.

3.  The left-most cell should appear darker than all the others.  Click on it.  It should now be as light as all the others.  Now when you move the cursor back onto the score, it should remain looking like an arrow.

Playing the MIDI File You've Loaded
1.  Under the "Score" menu, click on "Scroll tune" or do a Command+D.  This will not only cause the player to start playing and the cursor to follow the score, but it will cause the music to scroll while the music plays.  If you simply select the "Play tune" option (Command+M), you'll still get the moving cursor, but you'll have to scroll manually.

If the "Scroll tune" option is checked, but the music doesn't scroll, click on "Global setup" under the "Configuration" menu, and when the "setup" window opens, click on the tab labelled "Play", and make sure that both the boxes labelled "Scroll music while playing" and "Show played location in tune" are checked.  (For openers, don't check the "Automatically follow tune while playing" box.)

You will note that there are three scrolling options.  The default, and the one I myself prefer, is "Page after page," which causes the score to shift abruptly when the cursor gets to within a measure of the end of the viewing window.  With the other two options, the cursor stays fixed and the score constantly moves.  I find this both unnatural and disconcerting, but to each his own taste.

2.  Most of the play functions can be controlled only from the "Play tools" palette.  (Two exceptions to this are the Play/Stop function which can also be controlled from the "Score" menu, and the automatic scrolling which can only be controlled from there.)  So if the "Play tools" palette isn't already open, open it now (remember, it's under the "Windows" menu).  To locate the palette on your screen, it's the one with the loudspeaker image and the word PLAY in the far-left cell of the palette.

3. The basic tools you'll need for playing are the Play/Stop (first cell), Pause/Resume (second cell), Fast Forward and Reverse (third and fourth cells) and the volume control (third-from-last cell: the one with two yellow knobs).

As with a CD player, pause/resume will cause play to resume at the stopped point; Stop/Play will cause the music to start over from the beginning.  Neither of these controls will affect the the "Scroll tune" (automatic scrolling) option.  

If you have selected "Scroll tune", you'll find that fast forwarding/reversing will cause the music to scroll as the cursor repositions itself.

4.  To adjust the volume, click on the volume control cell, and when the "digital effects setup" window appears, use the mouse pointer to rotate the volume knob.  (I have only a vague idea what the other knobs do, and I've never used any of them).  If this doesn't give you sufficient control, you may have to adjust the overall sound level of the computer.  With a Mac, this is done using the "Sound" control panel (sorry, PC users, I don't know how to do that on a PC).

5.  At the bottom of the score you'll notice a gray scroll bar will a numbered box in it.  This box simply indicates/controls the location of the portion of the score which is visible in the viewing window.  It does not control the measure being played.  Moreover, using the scroll bar to reposition the score will turn off the "Scroll tune" option (you can turn in on again by doing a Command + D, and the music will automatically scroll to the measure being played).

6.  When you're finished with a given score and go to close the window, if you've made any adjustment (including simply changing the volume control), the program will ask if you want to save the changes.  As mentioned earlier, it is fairly safe to say "Yes", because the saved file will not (under the default option) change the original .mid file, but will create a new file which uses the .mus (rather than the .mid) format.  So even if you have second thoughts (or you've done something you can't figure out how to undo), you can always go back to the original .mid file and start over.

Aids in Practicing:
Controlling the Playing Speed
1.  Click on "General tempo" under the "Score menu.

2.  When the un-named tempo window opens, the overall general tempo will appear in the box in the middle.  You might want to make a note of this number so that you can restore the original tempo later on.

3.  Adjust the indicator on the bar below the line that says "Number of quarter notes per minute" until you achieve the desired speed (if the music is playing, you'll hear the playing speed change as you do this; whether or not it's playing, you'll see the number in the box changing).

4.  Cautionary note:  There was a bug in the early versions of the software that produced problems in pieces with multiple tempi, that not only caused non-proportionate changes to occur in the individual tempi but, when the original general tempo was restored, did not restore the individual tempi to their original values.  That bug was fixed as of version 5.8 (in response to it having been pointed out by yours truly--they are truly a responsive outfit); if you're using version 5.7 or earlier, you should probably upgrade.

Highlighting an Indiviual Part
1. Select "Staff display mode" under the "Staff" menu.

2. When the "Select staff" window appears, click on the staff you'd like to highlight.

3. When the "Staff Display Options" window appears, click and hold on the arrow at the right-hand end of the "Line color" window bar and select the color you'd like the selected staff to appear in; release the mouse button, and then click "OK"

Selecting a Particular Group of Measures to Play.
You can of course do this by fast-forwarding/reversing to the desired set of measures, but that tends to be cumbersome.  A better procedure is the following:

1.  Look under the "Options" menu to see that the "Display ruler" option is checked.  If it is, you should see the numbers of the various measure listed in a bar at the top of the score.  (If the option isn't selected, then select it now.)

2.  In the ruler bar, click on the first measure of the selection you'd like to play.  Then hold down the shift key and (using the scroll bar, if necessary to display it) click on the last measure of the selection.  If you've done this successfully, all staves of the selected measures should be highlighted in green.

3.  In the "Play tools" palette, go to the selection-range cell (the one immediately following the fast rewind cell) which contains an image of, if you think about it, a musical staff with an arrow over it. 

4.  In the "normal" play mode, the staff is blank and the arrow spans its entire length.   Click on the cell, and you should now see the center portion of the staff turn black, and the arrow shorten to span only the black region.  If you now hit play, only the selected measures will be played.

5.  To select a different set of measures, simply re-do step 2.  To play the entire piece, while retaining the present selection, just click again on the selection-range cell.  To de-select the selection, click on the score while holding down the option key (alt key on a pc?).

Selecting a Particular Voice Part or Parts to Play
1.  Instead of clicking on measure numbers in the ruler, use the scroll bar to position the music on measure 1 and click to the left of the staff for the part you want to play.  If you want to play a group of adjacent parts, after selecting the first part, hold down the shift key and click on the "most distant" adjacent staff you'd like included.

2.  Go to the "Play tools" palette and click on the selection-range cell.  Now instead of a range of measures, you'll play a range of staves.

3.  You can only select a range of adjacent staves to play.  If you want to play a set of non-adjacent staves, you can change the vertical ordering of the staves by holding down the Command key and clicking on the name of the staff you want to move (the pointer will turn into a hand) and, while holding down the mouse button, dragging it vertically until it is adjacent to staff you want to pair it with (the other staves will automatically re-position themselves to make room for the relocated staff).

4.  Cultural note:  If you simply want to adjust the vertical spacing between staves, rather than re-order them do the following:  At the left of the staves is what looks like a string of identical (very small) tool palettes, one for each staff.  Along the right edge of each palette is a small red triangle.  If you move the pointer over any of these triangles, you'll notice the pointer change as a small pair of up-down arrows appear alongside it.  If you now click on the red arrow and hold down the mouse button, you'll be able to reposition the staff vertically.

5.  Note:  It is is possible to select both a particular voice part and a range of measures to be played.  To do this, though, you'll have to select the "lasso" tool from the Editing tools palette (see steps 1&2 under the Cautionary Note in the section "Playing a MIDI File").  The lasso tool is activated by clicking on the second cell from the left (the one showing a note with a lasso around it).  Once the lasso tool is activated, click at the part and measure you want to start at, and hold down the mouse button, to make the desired selection; again, the selection-range cell on the "Play tools" palette must be activated.

Enhancing a Particular "Instrument" (i.e. Voice Part)
Rather than eliminating all other parts than the one you're interested in, you might wish simply to enhance that part (i.e. make it louder) relative to all the others. You can do this using the "Complete Mixer" palette.  In principle, you should simply have to turn up the volume on the "instrument" of interest (e.g., the alto voice).  However, in many of the MIDI files, the volume on all the individual instruments has been set (by the person who created the file) at maximum volume, so that you first have to turn down the volume on all the instruments before turning up the volume on the one you're interested in enhancing.  It turns out there's a quick way to do that.  Here's the procedure:

1.  Open the MIDI file you want to edit.

2.  Open the Complete mixer palette by going to the "Windows" menu, going to the "Mixer" line, and then selecting "Complete mixer" from the sub-window which appears.

The resulting control panel (labelled with the name of the MIDI file you're editing) will show a Master volume control at the left side, as well as balance and volume controls for all the instruments.  Also, for each of the instruments there will be two small icons, a loundspeaker and microphone icon, which also occur on the mini-palette that appears to the left of each of the staves on the MIDI score.  (If the volume controls for all instruments are set at mid-range--something I've found is rarely the case--you can skip directly to step 5.)

3.  Shift click on the Master volume control and adjust it counter-clockwise (you have to hold down both the shift key and the mouse button while doint this); you should see the volume controls on all of the instruments (but *not* the Master volume control itself) rotate counter-clockwise.  (If you don't hold down the shift key while you do this, you'll adjust *only* the Master volume control, but none of the individual ones.)  You'll probably want to set the controls at or below mid-range.

4. At this point, you might want to save the modified file.

5. To enhance the volume of the desired voice, locate its panel in the palette (you may have to scroll to the right to find it), and turn its volume control up (probably to full volume).

A slightly faster way to adjust the volume of the *individual* voices, rather than using the "Complete mixer" palette, is to click on the microphone cell in the mini-palette at the left of each stave.  This will open the Staff instrument editing panel which will contain a volume control for that particular instrument.

Adding Lyrics
Note:  If you're going to the trouble of doing this, then you'll definitely want to save the file when you're done.  Needless to say, you'll have to have an actual score in hand (or on screen) from which to transcribe the lyrics (although in the case of, say, the Vivaldi Gloria, one can make a lot of educated guesses).  There's also a procedure for importing lyrics from a separate file, but that means someone's already gone through the procedure given here in order to generate it.

1.  If you're only planning to enter the lyrics for a single voice part, the easiest way to go about it is to select "Edit lyrics" from the "Score" menu.

2.When the small window appears, it will ask you to select the part you wish to associate the lyrics with.  Choose the voice part (presumably your own) and click "Associate."

3.  An "Edit lyrics" window will now appear which, among other things, will allow you to select the font in which you'd like the lyrics to appear.  The window will also contain a smaller window within it in which a series of slashes will appear.  These represent the bar lines, and you can actually enter the lyrics here for each of the measures (to prevent you from going blind, there's a small legend above which will indicate what measure you're in when you click between a pair of slashes).  However, it's considerably easier to enter the words directly on the score; so after you've selected your font, just click "OK" to return to the score.  (However, see step 7.)

4.  You'll now notice a row of boxes, one per measure, located directly below (usually) the staff you chose to associate the lyrics with.  This is where the lyrics go.  To begin entering lyrics, hold down the option (or alt?) key and click in the box under the appropriate measure.

5.  MA will assign syllables to the appropriate notes, provided you adhere to a few simple procedures.

Insert hyphens between consecutive syllables within a word.

Insert a space or a tab between successive words.

If a syllable carries over several notes, you can extend it by inserting hyphens or spaces (you may have to do a little fine tuning on this one).

A tab will move you to the next syllable; the arrow key will move you to the next measure.

Note : The yellow bar lines indicate where line breaks will occur when the score is printed.  If a multi-syllable word spans a line break, a hyphen will automatically be inserted before the first syllable on the new line (God, isn't MA clever!); there's nothing you can do about that so don't waste time trying to erase it.

6.  This is not the sort of work you'd like to lose in the event of a computer crash, so it's suggested that you do save's at frequent intervals.

7.  Occasionally, you'll enter things in the wrong measure, get a spacing wrong, etc.  Usually you'll be able to fix this right in the score.  However, occasionally MA will screw things up, and lyrics erased from one measure will unaccountably pop up in another one.  If this happens, the only way I've found to fix this (it seems to be a program bug) is to go and do an "Edit lyrics" (see above), and correct the offending measures "manually"; it's a bit cumbersome, but I've always been able to fix things this way.

8.  (Optional/"Cultural") When you're all (or even part-way) done entering the lyrics, you can return to the "Edit lyrics" menu item.  You'll now see that the words you've entered appear between the appropriate bar-lines/slashes.  In fact the text+slashes is what will be saved in the form of a plain text (.txt) file if you go to export the lyrics file.

9.  VERY IMPORTANT.  If you originally downloaded Virtual Singer as part of the Melody Assistant packge, then once you have entered lyrics, MA will try to vocalize them using Virtual Singer.  My experience with Virtual Singer is that the voice it creates sounds like that of a superannuated frog with a severe case of laryngitis.  

To prevent the vocalization from occuring (i.e., to restore the original instrument sound to the line associated with the lyrics), click on "Virtual Singer" under the "Windows" menu.  The Virtual Singer window will open, displaying a Dracula-like character on a stage.  In the upper left-hand corner of the window (just above the bird image), you will see a small green dot.  If you click on the dot, it will turn red, and a red curtain will be drawn in front of the stage.  You can now close the Virtual Singer menu:  The frog has been silenced.  

